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THANK YOU FOR CHOOSING ROSS VIDEO

You've made a great choice. We expect you will be very happy with your purchase of Ross Technology.
Our mission is to:
1. Provide a Superior Customer Experience
« offer the best product quality and support
2. Make Cool Practical Technology
» develop great products that customers love

Ross has become well known for the Ross Video Code of Ethics. It guides our interactions and
empowers our employees. | hope you enjoy reading it below.

If anything at all with your Ross experience does not live up to your expectations be sure to reach out to
us at solutions@rossvideo.com.

'D.-Q 2“5

David Ross
CEO, Ross Video
david.ross@rossvideo.com

Ross Video Code of Ethics

Any company is the sum total of the people that make things happen. At Ross, our employees are a
special group. Our employees truly care about doing a great job and delivering a high quality customer
experience every day. This code of ethics hangs on the wall of all Ross Video locations to guide our
behavior:

1. We will always act in our customers’ best interest.
We will do our best to understand our customers’ requirements.
We will not ship crap.

We will be great to work with.

A

We will do something extra for our customers, as an apology, when something big goes wrong and
it's our fault.

We will keep our promises.
We will treat the competition with respect.
We will cooperate with and help other friendly companies.

© o No

We will go above and beyond in times of crisis. If there's no one to authorize the required action in
times of company or customer crisis - do what you know in your heart is right. (You may rent
helicopters if necessary.)

About this Guide

* Ross Part Number: 7800DR-021-12.5
* Release Date: July 11, 2025. Printed in Canada.

e Software Issue: 12.5

The information contained in this Guide is subject to change without notice or obligation.



Copyright

© 2014 - 2025 Ross Video Limited. Ross® and any related marks are trademarks or registered trademarks of Ross
Video Limited. All other trademarks are the property of their respective companies. PATENTS ISSUED and
PENDING. All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or
transmitted in any form or by any means, mechanical, photocopying, recording or otherwise, without the prior
written permission of Ross Video. While every precaution has been taken in the preparation of this document, Ross
Video assumes no responsibility for errors or omissions. Neither is any liability assumed for damages resulting
from the use of the information contained herein.

Patents

Patent numbers 4,205,346; 5,115,314; 5,280,346; 5,561,404; 7,034,886; 7,508,455; 7,602,446; 7,834,886;
7,914,332; 8307284, 2039277, 1237518; 1127289 and other patents pending.

Warranty and Repair Policy

Ross Video Limited (Ross) warrants its Streamline Pro Server systems to be free from defects under normal use and
service a time period of 15 months from the date of shipment:

If an item becomes defective within the warranty period Ross will repair or replace the defective item, as
determined solely by Ross.

Warranty repairs will be conducted at Ross, with all shipping FOB Ross dock. If repairs are conducted at the
customer site, reasonable out-of-pocket charges will apply. At the discretion of Ross, and on a temporary loan basis,
plug in circuit boards or other replacement parts may be supplied free of charge while defective items undergo
repair. Return packing, shipping, and special handling costs are the responsibility of the customer.

This warranty is void if products are subjected to misuse, neglect, accident, improper installation or application, or
unauthorized modification.

In no event shall Ross Video Limited be liable for direct, indirect, special, incidental, or consequential damages
(including loss of profit). Implied warranties, including that of merchantability and fitness for a particular purpose,
are expressly limited to the duration of this warranty.

This warranty is TRANSFERABLE to subsequent owners, subject to Ross’ notification of change of ownership.

Extended Warranty

For customers that require a longer warranty period, Ross offers an extended warranty plan to extend the standard
warranty period by one year increments. For more information about an extended warranty for your Streamline Pro
Server system, contact your regional sales manager.



Environmental Information

The equipment that you purchased required the extraction and use of natural resources for its production. It may
contain hazardous substances that could impact health and the environment.

To avoid the potential release of those substances into the environment and to diminish the need for the extraction
of natural resources, Ross Video encourages you to use the appropriate take-back systems. These systems will reuse
or recycle most of the materials from your end-of-life equipment in an environmentally friendly and health
conscious manner.

The crossed-out wheeled bin symbol invites you to use these systems.

If you need more information on the collection, reuse, and recycling systems, please contact your local or regional
waste administration. You can also contact Ross Video for more information on the environmental performances of
our products.

Use of Hazardous Substances in Electrical and Electronic
Products (China RoHS)

Ross Video Limited has reviewed all components and processes for compliance to:

“Management Methods for the Restriction of the Use of Hazardous Substances in Electrical and Electronic
Products” also known as China RoHS.

The “Environmentally Friendly Use Period” (EFUP) and Hazardous Substance Tables have been established for all
products. We are currently updating all of our Product Manuals.

The Hazardous substances tables are available on our website at:

http:// www.rossvideo.com/about-ross/company-profile/green-practices/china-rohs.html

FL gt FEL 7 it P AT S A o ) A

Ross Video Limited 4% # LAF (U bRiEXS FrG A AR EEAT 1 FF 25

“HLAS HLT T A ) R AR A B ARy b EROHS

Fr P A EA A GREE R IR (BFUP) MG HWmER. BT, FATIELE SR EAIA 87 i 0t
A EYBRAE AT PR 32k 2

http://www.rossvideo.com/about-ross/company-profile/green-practices/china-rohs.html



http://www.rossvideo.com/about-ross/company-profile/green-practices/china-rohs.html
http://www.rossvideo.com/about-ross/company-profile/green-practices/china-rohs.html

Company Address

Ross Video Limited

8 John Street
Iroquois, Ontario
Canada, KOE 1KO0

General Business Office:

Fax:

Technical Support:

After Hours Emergency:

Email (Technical Support):
Email (General Information):
Website:

Ross Video Incorporated

P.O. Box 880
Ogdensburg, New York
USA 13669-0880

(+1) 613.652.4886
(+1) 613.652.4425

(+1) 613.652.4886
(+1) 613.349.0006

techsupport@rossvideo.com
solutions@rossvideo.com

http://www.rossvideo.com
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Introduction

A Word of Thanks

Thank you for choosing Streamline Pro as your Ross Video media asset management solution.

We are committed to providing you with the highest level of customer satisfaction possible. If, for any reason, you
have questions or comments, please call Ross Video at +1-613-652-4886 or send us an e-mail at
techsupport@rossvideo.com.

We hope that you visit our website www.rossvideo.com to stay up to date with ongoing software releases, join our
customer forum and learn more about the complete range of Ross Video products.

Note that software maintenance and extended warranties are available for your system to protect and extend the life
of your investment. Our sales team is more than happy to provide further information on the plans available.
Members of our sales team will promptly response to e-mails sent to: solutions@rossvideo.com.

Again, thank you for your purchase of a Streamline Pro media asset management solution from Ross Video. We are
confident of your future pleasure with your choice.

Yours Sincerely,

Y/ A—

Peter Abecassis
Director of Product Management - Production Workflow
peter.abecassis@rossvideo.com
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About This Guide

This guide contains the following chapters that cover the use of the Streamline media asset management system:
1. Introduction — summarizes the guide and provides important terms, and conventions.

2. Getting Started — provides instructions on how to log into the Streamline Pro interface, summarizes the
interface, and how to personalize the layout of the plugin within your NRCS system.

Creating a Timeline — shows users how to create timelines in the Timeline Editor.

Adding Media to the Timeline —provides instructions on how to use the Media Browser.
Editing the Timeline — provides instructions on how to perform edits and arrange your Timeline.
Exporting the Timeline — provides instructions on how to export your completed timeline.

Ross Video Adobe Panel — provides instructions on how to import your timeline into Adobe Premiere Pro.

A

Glossary of Terms — lists Ross Video and general broadcast terminology used in this guide.

If you have questions pertaining to the operation of Streamline, please contact us at the numbers listed in the section
“Contacting Technical Support”. Our technical staff is always available for consultation, training, or service.
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Documentation Conventions
Special text formats are used in this guide to identify parts of the user interface, text that a user must enter, or a

sequence of menus and sub-menus that must be followed to reach a particular command.

Interface Elements
Bold text is used to identify a user interface element such as a dialog box, menu item, or button. For example:

In the Assets panel, click Delete.

User Entered Text
Courier text is used to identify text that a user must enter. For example:

In the Language box, enter English.

Referenced Guides
Italic text is used to identify the titles of referenced guides, manuals, or documents. For example:

For more information, refer to the section “User Role Configuration” in the Streamline Configuration Guide.

Menu Sequences

Menu arrows are used in procedures to identify a sequence of menu items that you must follow. For example, if a
step reads “File > Save As,” you would click the File menu and then click Save As.
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Important Instructions
Star icons are used to identify important instructions or features. For example:

X After upgrading Streamline software, you must obtain feature licenses from Ross Video Technical Support
before users can access Streamline features.

Getting Help

The Ross Video product Online Help system is accessed by selecting Help Topics from the Help menu in the
product. Alternatively, press the F1 key while working in a client or dialog box.

The Online Help system contains the following navigation tabs to locate information contained in the Online Help
topics and User Guide:

¢ Contents — table of contents
* Index — keyword reference
¢ Search — full text search

» Favorites — preferred information storage and access

Ross Video product guides are also supplied as print-ready PDF files on the Ross Video product Software.

Contacting Technical Support

Technical Support is staffed by a team of experienced specialists ready to assist you with any question or technical
issue.

Ross Video has technical support specialists strategically located around the globe to ensure a prompt response to
technical inquiries. Our primary technical support center is located in Ottawa, Ontario, Canada. In addition, we
have offices in The United Kingdom (London), Australia (Sydney), and Singapore with satellite locations in New
York City, The Netherlands, and China. As we expand our presence globally, we are constantly evaluating other key
locations to have a local technical support specialist in order to better service our customers.

North America

Our North America center located in Ottawa, Ontario, Canada and is open Monday to Friday 8:30 a.m. to 6:00 p.m.
EST, with 24/7/365 on-call service after hours.

Our telephone number is: +1-613-686-1557
Toll free within North America: +1 844-652-0645

EMEA

Our EMEA center is open Monday to Friday 8:30 a.m. to 5:00 p.m. GMT. After hours support is provided by our
North America location.

Our telephone number is: +44 (0)1189502446
International toll free: +800 3540 3545

If the local support specialist is not available, your call will be transferred automatically to our North America
center.
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Australia

Our Sydney, Australia office is located in Alexandria, NSW.

Our local support telephone number is: +1300 007 677

If the local support specialist is not available, your call will be transferred automatically to our North America
center.

Online

E-mail: techsupport@rossvideo.com

Website: open a support request using the link http://www.rossvideo.com/support/tech-support.html to open a
support request.
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Getting Started

The Streamline Pro Web Video Editor is an HTML friendly online video editor that can be accessed from any
supported web browser. Hundreds of daily headlines, teases, and voice-overs can be edited 30% faster, at half the
cost of a traditional craft editor, and with no additional hardware. The user-friendly web-based video editor is
lighter, faster and integrates seamlessly with the existing Streamline workflows, allowing more users to create more
content from anywhere. Streamline Xchange users can access it from the Video Editor tab or directly from their
bookmarked Streamline Pro Video Editor URL.

This chapter discusses the following topics:

* Starting the Streamline Pro Web Video Editor

+ Streamline Pro Video Editor Workflow

* Exploring the Streamline Pro Web Video Editor Interface
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Starting the Streamline Pro Web Video Editor

You can open the Streamline Pro Web Video Editor from the Streamline Xchange MAM user interface.

* NOTE: If you do not see a Video Editor tab in your Streamline Xchange expanded menu, please contact your
system administrator. An enabled Streamline Pro Video Editor license is required.

To open the Streamline Pro Web Video Editor

1. Use one of the following supported web browsers to open the Streamline Xchange Web Editor provided by
your Streamline administrator:

> Google Chrome™ 126.0 and later
» Apple Safari® 17.4.1 and later
The Streamline Xchange Sign In page opens.

streamline>
Xchange

Welcome Back!

2. Enter your Streamline Xchange credentials in the Username and Password boxes.

3. From the top menu of Streamline Xchange, to expand the menu select the button.
4. Select Video Editor to launch the Streamline Pro Web Video Editor.

streamline> >  Xplore  Workspace  Upload  System Monitor  Project Dashboard | Video Editor | Logout
Xchange

The Streamline Pro Web Video Editor opens in a new Tab.
5. Bookmark the Streamline Pro Web Video Editor page in your web browser.

© ANt sottmegandtro/phgin/edtorsesionToken-OORENAWMBECTAOMDOlG = o ome
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X For your security, Streamline automatically logs you out after 30 minutes of inactivity. If you sign in from
another device or browser tab, this session will automatically log you out.

To close the Streamline Pro Video Editor

1. In Streamline Pro tab, click the close icon X to end the Streamline Pro Video Editor web session.

2. Go to the Streamline Xchange Xchange - Xplore tab, from the expanded menu click Logout.
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Streamline Pro Video Editor Workflow

Streamline Pro is a premium Media Asset Management (MAM) solution that streamlines your content creation and
live graphics workflows. Streamline Pro integrates seamlessly with the Ross ecosystem - leveraging workflows
with the Ross Video Inception newsroom (NRCS) system, Streamline Xchange (MAM), and Media I/O playout
system. The Streamline Video Editor is a lightweight video editor that can be purchased with your Streamline Pro

and Streamline Xchange system.

(
Add Assets to the
Timeline

Upload Assets to
the MAM

Upload assets in Streamline
Xchange, and the media
assets will be available in the
Streamline Pro Video Editor in

Drag assets from the Media
Browser into your timeline.
Then Trim, splice, and apply
your edits to the assets using

the Timeline Editor.
TIP: Export timelines for more
edits in Adobe Premiere.

. J \. J

4 = 4
Search for Assets

the Media Browser panel.

\
Export the Timeline

Search for assets in
Streamline Pro Video Editor in
the Media Browser using
specific criteria. Use the filters
to sort by type and any other
custom filters.

. J . J

Export the video timeline in
your preferred video format.
Save the video to a Project
folder to have it appear the
Streamline Xchange MAM.

Required Components

Deployment Options
* On Premise:
> Streamline Xchange MAM Server
> Streamline Xchange MAM Web Client
> Shared Storage Device (such as Ross EVO Storage)
> Archive
* Remote or At Home:
> Remote MAM Web Client
> Remote Adobe Suite Clients
* Cloud Services:
> Cloud Archive

> Al Services

Optional Components
* XPression MOS Plugin
* Media I/O Video Server for Ingest and Playout
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Required Licenses

The Streamline Pro Web Video area requires a license to enable the Video Editor. You can purchase a Video Editor
license from a Ross Video Sales Representative.

Minimum Hardware Requirements

Database Server

* Windows Server 2019 64-bit

* 32GB Memory

* Intel Xeon E-2144G 3.6GHz or higher
» 2x480GB SSD SATA 6Gbps

Media Processing Server

* Windows Server 2019 64-bit

* 64GB Memory

* Dual Intel Xeon Silver 4214 or higher
+ 2x480GB SSD SATA 6Gbps

Supported Browsers
Currently supported web browsers include:

* Google Chrome 126.0 and later
e Safari 17.4.1 and later

Supported Media Formats

The following sections describe the media formats supported by the Streamline Pro system.

Thumbnail Viewing

Streamline Pro supports the following image formats for thumbnail viewing:
+ BMP

* GIF

« JPG

 PNG

+ TGA

* TIF

« WBMP

A PNG thumbnail is generated when Streamline Pro encounters one of the support formats. This thumbnail is
scaled down to fit within a 256x144 image.

For More Information on...
* The Streamline Xchange MAM Server, see the Streamline Xchange User Guide.

* The Inception Newsroom, see Inception User Guide.
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Video Playout

Streamline Pro supports video playout within your web browser using Flowplayer for the following formats:

Table 2.1 Supported Video Formats for Playout

Format Video Codec Audio Codec
F4V H.264 AAC
FLV Sorenson H.263 MP3
MP4 H.264 AAC

Metadata Collection

Streamline Pro supports the gathering of structural metadata using the Medialnfo tool. Refer to the Medialnfo
website for a list of analytics and supported file formats.
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Exploring the Streamline Pro Web Video Editor Interface

You can add media, audio, and still image clips to your video, and arrange elements temporally along the Timeline.
This includes configuring visual elements and audio tracks. You can preview assets you are considering adding to
your video, and set In and Out Points to choose a specific segment. Once you’ve finished trimming you can preview
and modify your video. You can review your video while on the go and export using one of the many supported

Streamline Pro export presets.

The Streamline Pro Web Video Editor consists of a Media Browser, an Asset Preview Player, a Timeline Preview
Player, and a Timeline Editor.

* A blue highlight around a panel indicates that it is the actively selected panel, and that your changes will be
applied to this panel.

Asset Preview Player Timeline Preview Player

Search Bar

Media Browser

Timeline Editor Audio Meter

Figure 2.1 Overview of the Streamline Pro Web Video Editor

Overview of the Media Browser

The Media Browser allows you to search for assets, filter by type, archive status, category, approval status, editor,
location, and additional custom fields. You can also navigate to Projects or Smartbins to locate a specific asset. It is
located in the top left quadrant of the Streamline Pro Web Video Editor.

The Search View displays assets that match your specified criteria and filter settings. Any matching assets that have
been uploaded to the Streamline Xchange MAM will appear, allowing you to quickly access individual assets or
search the Streamline Pro system for specific assets. The displayed search results are listed by upload date (from
most to least recent). From the Search View, you can drag and drop an asset directly into the Timeline Editor.
Alternatively, you can double-click to preview the asset in the Asset Preview Player.

Search Bar

) Q haly

Filters  Projects Smartbins

Filter and Storage {
Tabs

Asset Type
8B ¢ n
[}

Asset Type Filters

Assets from Search

Arcl
Results

g eivoos
01/09/2024 10:44:07

Filters Shot Type

9/9 Items

Figure 2.2 Media Browser Interface
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The Media Browser toolbar contains the following icons:

Table 3: Media Browser Toolbar Icons

Icon Name Description
Video Enables you to filter your search results by asset
=] type for video assets.
Audio Enables you to filter your search results by asset
© type for audio assets.
Image Enables you to filter your search results by asset
E type for image assets.
Document Enables you to filter your search results for
E documents.
Project File Enables you to filter your search results for project
n files.
n Folder Opens the project folder in the Projects tab.
E Smartbin Opens the Smartbin folder in the Smartbin tab.

Overview of the Asset Preview Player Controls

The Asset Preview Player displays assets from the Media Browser. Once an asset has been clicked, it opens in the
Asset Preview Player, where you can preview it with the player controls, or set In and Out Points to select a
sequence from a selected video or audio asset.

Preview of the
Selected Asset

J

Asset Preview 00000000 } Current Time
Timeline and End Time

Playhead Asset Playback Controls
In Out Frame Play Frame Overwrite
Point Point Forward or Back
Pause

Figure 2.3 Asset Preview Player
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The Asset Preview Player contains the following playback controls:

Table 4: Asset Playback Controls

Icon Name Description
= Overwrite Inserts the audio or video clip from the Asset
. Preview Player into the Timeline Editor at the

playhead position. If In and Out Points have been
marked, then only the indicated sequence will be
inserted.

* NOTE: If a media asset currently occupies the
position next to the playhead (insertion point) in
the Timeline Editor, then the previous media asset
will be overwritten.

Frame Forward Moves the playhead to the next available frame in
the Asset Preview Player.

Play Plays the previewed asset.
* SHORTKEY: Press the space bar to play or
pause the actively selected window.
Pause Pauses the previewed asset.
* SHORTKEY: Press the space bar to play or
pause the actively selected window.

Frame Back Moves the playhead back a frame in the Asset
Preview Player.

Out Point Marks the Out Point to set where the clip playback
will end.

In Point Marks the In Point to set where the clip playback
will begin.

Playhead Indicates the currently displayed frame of the asset.

Click anywhere along the Preview Player timeline
to drag the playhead to a new position.
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Overview of the Timeline Preview Player Controls

The Timeline Preview Player displays a preview of your open Timeline track. You can preview it with the player
controls, or set In and Out Points to choose a segment of the Timeline track that you wish to export. The playhead
displayed in the Timeline Preview player is synchronized with playhead on the Timeline Editor.

Preview of the
Timeline

3 Current Time and
End Time

Timeline {

Playhead Asset Playback Controls

A\

In Out Frame Play Frame
Point Point Forward or Back
Pause

Figure 2.4 Timeline Preview Player

The Timeline Preview Player contains the following playback controls:
Table 5: Timeline Asset Playback Controls

Icon Name Function
Frame Forward Moves the playhead to the next available frame in
n the Timeline Preview Player.
n Play Plays a video preview of the open Timeline Editor
track.

SHORTKEY: Press the space bar to play or pause
the actively selected window.
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Table 5: Timeline Asset Playback Controls

Name Function

Pause Pauses the video preview of the open Timeline
Editor track.

* SHORTKEY: Press the space bar to play or
pause the actively selected window.

Frame Back Jumps to the start of the previewed Timeline Editor
track.

Out Point Marks the Out Point to set where the clip playback
will end.

In Point Marks the In Point to set where the clip playback
will begin.

Playhead Indicates the currently displayed frame of the asset.

=

Click anywhere along the Timeline Preview Player
timeline to drag the playhead to a new position.

TIP: You can also adjust the position of the
playhead on the main Timeline Editor.

Overview of the Timeline Editor Toolbar

The Timeline Editor allows you to trim, split, and arrange assets over time. Once media assets from the Media
Browser have been dragged in, the audio tracks will appear as A1, A2 and video tracks appear as V1, V2. These
tracks can be reordered or trimmed as needed. You can edit with confidence knowing that your changes do not
affect the asset source files stored in the Streamline Xchange MAM. Any unnecessary changes can be easily
undone, or redone as you play your content in the Timeline Preview Player.

You can adjust audio gain by hovering over the audio track, and drag the white horizontal Audio Level line up or
down. An audio meter allows you to monitor channel tracks.

After mapping all your edits, you can export the full timeline or mark the In and Out Points to export a sequence
using your preferred export settings in the Export wizard.

Timeline Toolbar Export Toolbar

Video Tracks

Audio Meter

Audio Tracks

N——
Left and Right
Audio Channels

Streamline Pro Streamline Pro User Guide (v12.5) Getting Started * 2—11



Use the Timeline Editor icons to apply your edits and export your video:
Table 6: Timeline Editor Toolbar Icons

Icon Name Description
Select Use this button to select and move assets in the
Timeline Editor.
ﬂ Razor Use this button to cut a clip.
Undo Use this button to undo the last change made.
Redo Use this button revert back to the most recent
change that was made.
E New Use this button to create a new Timeline.
* IMPORTANT: Save the current Timeline before
use, because it will delete the open Timeline.
Save Use this button to save the current Timeline track.
E A Confirmation notification appears.
Export Use this button to export the Timeline.
— * TIP: To export a segment of the timeline, select
In and Out Points.
. Solo Left Displays the audio level for the left channel.
. Solo Right Displays the audio level for the right channel.
Playhead Shows the current timestamp of the timeline editor
I track, allows the user to navigate through the track.
Video 1 A video clip on the Timeline. A V2 track displays
Audio 1 An audio clip on the Timeline. An A2 track
_ displays below Al.
Unmute Displays an unmuted audio track. Click this button
® to mute an audio track.
Mute Displays a muted audio track. Click this button to

Zoom Slider

unmute the audio track.
* NOTE: Muted tracks will not produce sound
during playback and Timeline exports.

Move the slider left to zoom in and move the slider
right to zoom out.
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Overview of the Audio Meter and Audio Leveler

The Audio Meter is a VU meter that allows you to monitor audio when using the Timeline Preview Player. If levels
need to be adjusted, you can mouse over an asset to see the Audio Leveler tool appear.

Audio Meter The Audio Meter is a VU meter that allows you to
monitor gain levels on a media asset or segment on
the timeline.

TIP: Use the Audio Leveler tool to adjust the gain.

4 sports2-min | Audio Leveler The Audio leveler allows you to adjust the volume
up or down by moving the white Audio Level line
on the track. It is measured in dB.
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Creating a Timeline

A video timeline provides a starting point for you to arrange your video clips and plan out all the edits you’d like to
apply. When you open the Streamline Pro Web Video Editor, a blank video timeline opens in the Timeline Editor
panel. It provides a chronological view of your video project and the timestamp interval markers allow you to
distribute media clips at exactly the right frame. As you add video clips, audio clips and other media you can move
the playhead to the spot you wish to view, and use the Zoom Slider beneath the Timeline Editor to work with
different areas of the timeline track more closely. Changes to assets on the timeline will not alter source assets in the
Media Browser panel.

For More Information on...

* basic editing, see “Editing the Timeline”.

This chapter discusses the following topics:

* Creating a New Timeline
* Saving a Timeline

* Opening an Existing Timeline

Creating a New Timeline

When you open the Streamline Pro Web Video Editor, a blank timeline is already present in the Timeline Editor
panel.

To Create a New Timeline

* IMPORTANT: When you follow the steps below, your currently open timeline will be deleted when you click
the New button.

1. Go to the Timeline Editor menu, and to save your existing timeline, click E Save.
a. Enter a name for your timeline and select Save.

* CAUTION:
Following the next step will delete the currently open timeline.

2. To create a new timeline in the Timeline Editor menu, click the m New button.
The New Timeline dialog opens.
New Timeline

Name
New Timeline
Frame Rate
29.97 (DF)
Frame Size

1920x1080

Cancel Create k
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3. Ifyou do not wish to use the default timeline settings, please enter the following:

« Name — Enter a name for the timeline.
* Frame Rate — Select a Frame Rate.

¢ Frame Size — Select a Frame Size.

* Once your changes are made, select the Create button.

Your new video timeline opens in the Timeline Editor:

Saving a Timeline

After a timeline is saved for the first time it is unnecessary to save it again, because Streamline Pro enables an
autosave feature. The Autosave button will replace the Save button on the Timeline Editor menu. If the Autosave
button is displayed it is no longer necessary to save it. Saved timelines can be found in the Media Browser >
Projects tab in the folder you selected.

* NOTE: If you exit or your session times out before saving, when you next sign in a prompt will ask if you wish
to open your unsaved session.

To Save a Timeline

1. Click the E Save button in the Timeline panel to save your timeline.
The Save As dialog appears.

2. Choose a Streamline Xchange Project folder, or placeholder to save your timeline to.
3. If desired, enter a meaningful name for the saved timeline.

4. Click the Save button to confirm.
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Opening an Existing Timeline

To Open an Existing Timeline

1. Go to the Media Browser > Projects and navigate the folder the timeline is saved in.

2.  Double-click on the project to open it.

The Open Saved Timeline dialog opens.

Open Saved Timeline

Are you sure you want to open the saved timeline?

Any unsaved changes to your current timeline will be lost if you proceed.

Cancel Accept k‘

3. Click Accept.

The timeline opens.
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Adding Media to the Timeline

The media assets, such as project folders, videos, and images, that are available in the Media Browser search results
allow you to access all the content that you’ve uploaded to the Streamline Xchange MAM.

You can enter search keywords and apply search filters to set a criteria for specific type content. Media Browser
automatically updates the panel to display the results for a search. When a panel opens, it displays the results of the
last search performed in that panel.

This chapter discusses the following topics:
* Searching for Assets
* Previewing Assets

* Loading Assets in the Streamline Xchange MAM
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Searching for Assets

The media assets, such as video clips and audio clips, that are available in the Media Browser give you full access
to all the content that you’ve uploaded to Streamline Xchange MAM.

You can enter search keywords and apply search filters to set a criteria for specific type content. The Media
Browser automatically updates the panel to display the results for a search.

To search for a media asset

You can search for a media asset by name or unique ID. You can also filter by asset type or one of the options
configured by your Streamline administrator (such as by archive status, approval status, shot type, the name of the
editor, content category, and location).

1. To search for an asset, navigate to the Media Browser panel.
a. Inthe Search field, enter the name, unique identifier, or custom field of the asset you wish to find.

Tip: If you have a large number of assets with similar names, it is recommended that you search by unique
identifier.

b. To filter for a specific type of asset, use the filter buttons to select the asset type(s) of your choice.
c. Select any additional custom filters that you wish to apply from the drop-down menus.
d. To initiate your search, in the Search field press enter.

2. Scroll through the assets in the Search View and double-click on any you wish to preview.

3. Assets, such as Video and Audio clips, are now visible and able to be selected based on your filters.

To open assets in a project
1. Inthe Media Browser, navigate to the Projects tab in the asset panel.

2. Enter the name of the timeline in the Search field.

TIP: Alternatively, search by project name, or navigate to the n Project folder manually.

3. Select and drag any of the project’s media assets from the Media Browser to the timeline.

To use smartbins

1. Navigate to the Smartbins tab in the asset panel.

2. Clickona H Smartbin in the list on the left side of the panel.

3. Select and drag an asset from the smartbin to the timeline.
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Previewing Assets

To preview assets

1. Navigate to the desired video or audio asset in the media browser. Double-click the asset to open it in the asset
preview player.

2. Select the u Play button to begin previewing the asset. Video clips will play in the panel, and audio clips
will be visually displayed.

To insert an asset into the timeline from the Asset Preview Player

1. With a video or audio asset open in the asset preview player, position the Timeline Editor playhead to the
location where you would like the asset to be inserted.

2. Click the . Overwrite button in the asset preview player to insert it into the timeline.

* NOTE: Upon replacing an asset with one from the asset preview player, the existing asset(s) on the timeline can
be deleted to create space. To avoid this, drag and drop any assets located where you intend to insert the new
asset to different locations on the timeline.

Loading Assets in the Streamline Xchange MAM

If you do not see the assets you need in the Media Browser, you must upload your assets in the Streamline Xchange
MAM.

* For more information, refer to the Streamline Xchange User Guide.

To load assets in Streamline Xchange

1. From the top menu of Streamline Xchange, to expand the menu select the button.
2. Select Upload to open the Xchange - Upload Manager page.

3. After selecting your preferred Project Folder, navigate to the Files tab on the upper right corner. Drag and drop
the asset you wish to upload.

4. After uploading an asset, return to the Streamline home page in the Xchange - Xplore tab and select System
Monitor to view the progress of the upload.

Streamline Pro Streamline Pro User Guide (v12.5) Adding Media to the Timeline * 1-3



* NOTE: If you can’t see an asset you’ve uploaded in Streamline Xchange or in the Streamline Pro Web Video
Editor, contact your Streamline administrator to ensure you have the proper permissions and to further
troubleshoot the issue.
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Editing the Timeline

The Timeline editor allows you to perform speedy edits to your media assets 30% faster than a traditional editor.

This chapter discusses the following topics:
+ Editing Basics

+ Editing Audio

» Editing Video

* Advanced Tips

For More Information on...

* exporting a sequence, see “Exporting a Sequence or Segment from the Timeline”

Editing Basics

Edit with confidence knowing that your changes will not affect source files.

To undo your changes

1. Locate the row of buttons on the top left of the Timeline panel.

2. Click the Undo button to go back to your last change.

To redo your changes

1. Locate the row of buttons on the top left of the timeline panel.

2. Click the Redo button to perform your last change.

Editing Audio

You can level audio by increasing or decreasing the audio on tracks that vary, as shown the figure below. You can
also use the audio leveling tool to reduce background noise between speakers or to remove undesirable noises.
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4 Undo  C* Redo

Figure 1.1 Increasing the volume of the clip on the right to match the first audio clip

NOTE: Even after the audio is leveled, the waves on the segments do not have their appearance altered to reflect
these changes.

To adjust the audio levels on an audio clip

1. On the Timeline Preview Player, click uPlay, and use the VU meter to check your audio levels.

2. Isolate the audio clip that you wish to adjust the audio on by moving the playhead to the start of the segment,

and click the = Razor tool. Move the playhead to the end of the audio segment you wish to edit, and click

the = Razor tool.

3. Now that your audio segment is ready, mouse over the audio segment.

A white horizontal Audio Leveler line appears. It measures the audio level in decibels (dB).

o} sports-2-min |

4. Move the Audio Leveler line up or down to adjust the volume.

Editing Video

To edit video clips
1. With a video clip already in the timeline, drag the desired video asset onto the timeline from the media browser.

2. Drop the new clip onto the preexisting clip.
The preexisting clip will be cut to fit the new video asset.

To trim clips

1. Place your cursor on the left or right side of the clip on the timeline. Click and drag the border of the clip on
either side to shorten it.

2. To trim the clip back to its original length, click and drag the border of the clip again. Drag the border away
from the clip to add the trimmed length back.
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To splice a clip

. . . . . . \s
You can use the Razor tool to spice clips. After you’re finished razoring clips, you must click the Select . button
to arrange clips on the Timeline.

1. In the timeline, move the playhead to the point at which you want to cut the clip.

2. Click the = Razor button.

3. Hover your cursor over the clips in the timeline. A vertical white line will indicate where the Razor tool is
going to cut the clip. This indicator will snap to the playhead’s position when the cursor hovers over it.

4. Click to cut the clip. Click the Select button again to move the newly separated clips.

Figure 1.2 The Razor tool splicing the video clip named Italy.

To arrange a clip
1. Click and drag your desired clip on the timeline.
2. Drag the clip to a different point on the timeline, or to a different track.

* SHORTCUT: To select all, press CTRL + A.

To remove a clip

1. In the timeline, click on the desired clip.
The clip’s border changes from yellow or purple to blue.

2. Press the Backspace key on your keyboard to delete the clip from the timeline.

To preview a clip

1. Inthe Media Browser in the Assets Panel, double-click a clip.
The Asset Preview Player displays the clip.

2. Click the - Play button in the Asset Preview Player to preview the clip without having it in the timeline.
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Advanced Tips

You can use the Asset Preview Player to speed up your edits by inserting existing media on your timeline track
exactly where you need it. It will overwrite any content occupying the space prior to insertion.

To insert audio or video media on the timeline

1. Inthe Media Browser panel, double-click on the video or audio asset you may wish to add to your timeline.
The asset opens in the Asset Preview Panel.

2. Inthe Asset Preview Panel do the following:

a. To add the entire asset - click the . Overwrite button to insert the previewed clip into the Timeline
Editor at the playhead.

b. To add a select sequence - use the buttons to mark In and Out points to mark the beginning and
end points. Click the Overwrite button to insert the previewed clip into the Timeline Editor at the
playhead.

The media or audio clip will be inserted at the playhead, and if other media is already occupying that space, the
inserted media will overwrite the previous audio track.
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Exporting the Timeline

This chapter discusses the following topics:

* Previewing the Timeline
* Exporting a Sequence or Segment from the Timeline

» Exporting the Timeline

Previewing the Timeline

To Preview your Timeline

1. Upon placing an asset in the timeline, it will appear in the Timeline Preview panel.

2. Press the u Play button to begin previewing the timeline. This will display the video clips in the panel and
play the audio clips through the connected audio output device.

Exporting a Sequence or Segment from the Timeline

To Mark In and Out Points on the Timeline Preview Player

1. With assets placed on the timeline, move the playhead to where the In Point will be in the Timeline Preview
Player.

2. With the playhead positioned, click the In Point button on the Timeline Preview Player to create the In
Point.

3. In the timeline or the timeline preview player, move the playhead to where the Out Point will be.

4. Click the Out Point button to create the Out Point.

5. Now that your In and Out Points are set, you can proceed to “Exporting the Timeline” on page 1-2.

To Remove In and Out Points on the Timeline

1. In the Timeline Editor, right-click on either of the red bars that indicate the In and Out points, and from the
dropdown menu select Clear In & Out.

¥ Select & Razor 5 Unde

3 Undo

.00;00

| C* Redo
Clear In
Clear Out
Clear In & Out

o} Ialy-005
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Exporting the Timeline

NOTE: If you attempt to export to a placeholder that is already in the process of exporting, you will see a ‘Failed to
Export’ notification in the top right corner.

To export to a project, placeholder, or smartbin

1. Click the Export button in the timeline panel.
2. Under the Select Destination step, add Filters if necessary.
3. To export to a project, smartbin, or placeholder, follow the appropriate sub-step below:

» To export to a project, click the Projects tab and select a project.
» To export to a placeholder, click the Projects tab, navigate to the placeholder and select the file.

» To export to a smartbin, click the Smartbins tab and select a smartbin.
4. Once you have chosen a project, placeholder or smartbin, click Next.
5. Inthe Export Settings, enter a meaningful Name and the select the preferred Preset you wish to use.

6. Select Export to export the timeline.
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Ross Video Adobe Panel

The Ross Video Adobe Panel is a powerful tool that enables seamless integration between the Adobe suite and
Streamline Xchange MAM. With the ability to search, edit, and export files directly from Adobe applications, this
panel enables you to work quickly and efficiently from anywhere, whether on-premise or remote.

Figure 1.1 Ross Video Adobe Panel

This chapter discusses the following topics:

* Importing Timelines into Adobe Premiere Pro
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Importing Timelines into Adobe Premiere Pro

You can import timelines from the Streamline Pro Video Editor into Adobe Premiere Pro for more touch ups using
the Ross Video Adobe Panel.

streamline>
Xehange

< IARTBINS PROJECT: >

To import Streamline Pro Assets into the Ross Video Adobe Panel
1. In the Streamline Xchange - Explore pane, click or tap the Project tab, select the timeline you wish to import.
2. Click Actions.
3. Select Import Timeline from the drop-down menu.
The timeline is imported into the Project pane.

4. In the Project pane, expand the Timelines from Streamline folder. Double-click the imported timeline.
The timeline opens in the lower right quadrant.

5. Apply your edits in the timeline.

6. Preview the changes in the Program pane.
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Glossary of Terms

A

Asset — a metadata container for content. An asset can have a single file associated which is called the essence. An
asset without an essence is called a placeholder.

APC — this acronym stands for Automated Production Control, and in this document it is used to describe the Ross
Video OverDrive (APC) system.

D

Default File Storage — the file storage used to store asset essences when a user does not select a file storage when
they upload a media file to Streamline Pro.

Derived File — a file crated from another file, for example: scaled images, thumbnails, low res video proxy files,
or formats created by a transcoder.

E

Essence — the primary file associated with an asset. An essence can have a thumbnail and proxy as previews for
the associated Asset.

F

File — a single file stored on a Streamline Pro Server. A file can have one or more file locations, but only one file
location can be the Primary file location. The first file location in which the file is stored becomes the initial
Primary file location for the file. A file with no file locations is invalid and will be deleted from the Streamline Pro
Server.

File Location — an instance of a single file in a file storage. Properties of the file, like path and name, must match
the rules defined for the file storage.

File Storage — an extension of a file system that contains file locations for files. A file storage can be configured
with rules to control the behavior of file locations in the file storage, for example: naming rules, pathing rules, and
ingest validation.

File System — a defined location used to store files, for example: a local hard drive, cloud storage, FTP servers, or
any other device that can be used to store data.

Format — a file derived from the original file that is considered interchangeable with the original. A format
derived from the asset essence can be used in place of the Essence when pushing to file storages with incompatible
ingest validation.

Fulfill — the process of storing a file in a placeholder asset. The file used to fulfill a placeholder becomes the
essence of the asset.

Indexed File Storage — a file storage that the Streamline Pro Server monitors to discover files which the server
has not yet ingested. Indexed files are ingested into the Streamline Pro Server to create new assets.

Ingest — the process of uploading a file into a Streamline Pro Server, usually to create an asset. Ingest can also
refer to storing an existing file into another file storage.
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Ingest Trigger — a defined event configured for a file storage to trigger a push to the file storage. Mirror is an
example of an ingest trigger that will push to a file storage when a file location is stored on another file storage.

Ingest Validation — a condition that must be met for a file to be stored on a file storage. For example, the Require
Asset Approval condition only allows files on the file storage where the associated Asset is approved.

M

Mapping Profile — a combination of metadata pairs from two different objects that are used to set data from one
side of the pair to the other. For example: with an asset and file object pair, Streamline Pro uses metadata from the
file to set the metadata for the asset associated with the file.

Metadata — a set of data that provides information for another piece of data.

MOS 4 — MOS 4 is the latest update to the industry standard communication protocol between newsroom devices
and control systems. MOS 4 allows for direct and secure communication between OverDrive and NRCS systems
located on different networks or in the cloud. This allows for more flexibility and reduced complexity when moving
parts of your newsroom infrastructure off-site or to public or private cloud data-centers.

N

Naming Rule — a rule applied to the file name of file locations when a file is stored in a file storage. One or more
naming rules can be configured for a file storage and are applied in sequential order. Example naming rules would
set name casing or maximum length.

NRCS — this acronym stands for News Room Control System, and in this document it is used to describe the Ross
Video Inception (NRCS) system.

P

Pathing Rule — a rule applied to the folder path of a file location when a file is stored in a file storage. One or
more pathing rules can be configured for a file storage and are applied in sequential order. The resulting
combination of all pathing rules are appended to the root of the file system set and will be the physical placement of
the File Location.

Placeholder — an asset that does not contain an essence. Placeholders are typically used to hold metadata for a
future file that will become the asset essence. Ingesting a file into a placeholder fulfills the asset.

Primary File Location — a special file location that cannot be deleted until all other locations of a file have been
deleted, or the entire file or associated asset has been deleted. The Primary file location can be changed to another
file location of the same file at any time.

Proxy — a preview for a video file. A typical proxy for a video file is a low-resolution version of the original file
that can be played in a web browser.

Push — the process of sending a file to another file storage to create a new file location.

T

Task — an operation running in the background on the Streamline Pro Server.

Thumbnail — an image that represents a file. A typical thumbnail for an image is scaled down version of the
original file.
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W

Watch Folder — a configured location in a file system to watch for new files to ingest into the Streamline Pro
Server. In contrast to a file storage, files are not kept in a watch folder for storage but are only used to discover new
files to ingest into permanent storage.
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